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1 Legal/Copyright Notice

Copyright Notice
This document is provided for informational purposes only. TNT Software, Inc.
makes no warranties, either express or implied, in this or about this document.
Information herein, including references, cites, URLs and other references, is
subject to change without notice. The entire risk of the use or the results of the
use of this document remains with the user. Complying with all applicable
copyright laws is the responsibility of the user. This document and its contents are
Copyright © 2018 TNT Software, Inc. All rights reserved.
Without limiting any rights, no part of this document or file may be reproduced,
stored in or introduced into a retrieval system, or transmitted in any form or by
any means (electronic, mechanical, photocopying, recording, or otherwise), or for
any purpose, without the express written permission of TNT Software, Inc.

TNT Software, Inc. may have patents, patent applications, trademarks, service
marks, copyrights, or other intellectual property rights covering this document and/
or its subject matter. Except as expressly provided in any written software license
agreement (SLA) from TNT Software, Inc., the furnishing of this document does not
give you any license to these patents, trademarks, copyrights, or other intellectual
property. The names of actual companies and products mentioned herein may be
the trademarks of their respective owners.

Legal Notice
TNT Software, Inc. provides this document "as is" without warranty of any kind,
either express or implied, including, but not limited to, the implied warranties of
merchantability or fitness for a particular purpose. Some states do not allow
disclaimers of express or implied warranties in certain transactions; therefore, this
statement may not apply to you.
This document and the software described in this document are furnished under a
license agreement or a non-disclosure agreement and may be used only in
accordance with the terms of the agreement. This document may not be lent, sold,
or given away without the written permission of TNT Software, Inc.. No part of this
publication may be reproduced, stored in a retrieval system, or transmitted in any
form or by any means, electronic, mechanical, or otherwise, without the prior
written consent of TNT Software, Inc..
U.S. Government Restricted Rights: Use, duplication, or disclosure by the
Government is subject to the restrictions as set forth in subparagraph (c)(1)(ii) of
the Rights in Technical Data and Computer Software clause of the DFARs 252.227-
7013 and FAR 52.227-29(c) and any successor rules or regulations.

TNT Software, Inc.
2001 Main Street
Vancouver, WA 98660
http://www.tntsoftware.com
Phone: 360-546-0878
FAX: 360-546-5017

http://www.tntsoftware.com
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2 Getting Started

This reference guide may be accessed directly via the ELM Dashboard Menu under
the Tools Option.
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3 The User Interface

The ELM Dashboard 7.0 has three primary components:  The ELM Menu, the Ribbon
Toolbar and Documents.

ELM Menu

The Menu contains options for the dashboard color Theme, dashboard Server
Connections, Start Page and Tools.

The Ribbon Toolbar

The dashboard commands are accessed primarily through the Ribbon Toolbar.  The
default View tab for the Ribbon acts a "Home" page and always remains constant. 

Documents

Documents contain information regarding specific elements in ELM. For example
an Agent Document contains data about a particular agent's performance or event
details.  When Documents are displayed they use a set of pre-defined Document
Displays based on the information that is being displayed.

Document Types:
Dashboard
Agent
Start Page
Connect

3.1 ELM Menu

Connect

Connect provides a Document that allows connections to an ELM management
server.

Options

The Options area provides access to change the display Theme.

Support

The Support menu option gives you access to the getting started page, launching
this Help Manual and the ELM Diagnostic tool.  In addition we provide links to
help resources on our website along with information about how to contact
technical support regarding ELM.

Tools
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The Tools menu option provides a single location to access various ELM features.
Please note some features will only function if ran on the ELM server directly.

About

The About area provides useful information such as Contact Information,
Updates, Licensing status, etc.

Exit

Exits/Closes the ELM Dashboard.

3.1.1 Connect

The Connect Document allows you to connect the Dashboard to an ELM Server. 
Configurable options include a Resolvable ELM server Name and the Port on which
to connect.  

If the Dashboard is connected to an ELM server you will see status information
about that connect near the bottom of the Document.

Note: The default port for connecting a Dashboad to an ELM server is 1351.
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3.1.2 Options

The Options menu provides access to change the display Theme.

ELM Light

ELM Dark (Default)
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3.1.3 Support

The Support menu option gives you access to the getting started page, launching
this Help Manual and the ELM Diagnostic tool.  In addition we provide links to help
resources on our website along with information about how to contact technical
support regarding ELM.
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3.1.4 Tools

The Tools menu option provides a single location to access various ELM features.
Please note some features will only function if ran on the ELM server directly.
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Start Page - Provides an overview of the ELM Dashboard.  
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Check for Updates - Connects to https://www.tntsoftware.com to check for any
program updates/upgrades.

ELM Event Generator - This tool is capable of generating test events utilizing
locally installed application message dll's.  This helps to provide simulated events
in testing Event Views and/or Notifications.

https://www.tntsoftware.com
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ELM Agent UI - This launches the TNTAgent.exe interface.  The interface can be
used to view agent activity and server registration status of the agent.
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ELM Agent Registration - Opens the Agent wizard to register with a ELM server. 
This may also be accessed through the Agent UI under the File menu.

ELM Console - Primary ELM user interface for the ELM server.

ELM Control Panel - Provides addition program options in configure the ELM
server.
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ELM DB Sizing Tool - Provides analysis of existing Windows event logs to
determine potential database size requirements based upon the number of events
currently stored.
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ELM Tracing Tool - The ELM Tracing tool is typically used at request of a support
technician.  The program is capable of running real time program diagnostics to
assist in resolving issues.

ELM Verify Event File - This is used to verify the integrity of an .evtx file that had
a MD5 hash file created during collection. It can also be used to uncompress
collect .evtx files.
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3.1.5 About

About provides a single location for view information about your ELM installation.

Product Information

Displays product version information and license status.

Contact Information

This area gives you information on how to contact TNT Software, Inc. including
email addresses, office location and telephone numbers.
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3.2 Ribbon Toolbar

The Ribbon is context-sensitive and automatically displays options based on what
is available in open Documents.

Home
The Home Ribbon consists of three sections: Document, Table and Status

Document

Dashboard button
This Dashboard button document option opens the Dashboard document.  

Agent
The Agent document option allows you to change the Agent server you are
viewing.  However if the Dashboard document is currently open and selected, the
only option is "Dashboard"
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Display
The Display option changes which type of data is displayed in an Agent
document.  Ex: Performance data, Network chart, etc.  Default display is Event
data.

Table

Column Layout
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Column layout options provides a specific set of predefined columns for display.

Select Columns

This menu options allows you to customize the columns in a selected Document
Display.  The columns available will vary based upon the data being displayed. 

Merge Cells

Merge Cells is a grouping function for displayed columns.  The grouping is based
on sort order and will group columns such as Date/Time and Event Types. 
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Status

These options will clear the Current and Peak Values columns on the Dashboard
document or when viewing the "Status" display in an Agent Document.
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3.2.1 Home

The Home Ribbon consists of three sections: Document, Table and Status

Document
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Dashboard button
This Dashboard button document option opens the Dashboard document.  

Agent
The Agent document option allows you to change the Agent server you are
viewing.  However if the Dashboard document is currently open and selected, the
only option is "Dashboard"

Display
The Display option changes which type of data is displayed in an Agent
document.  Ex: Performance data, Network chart, etc.  Default display is Event
data.
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Table

Column Layout

Column layout options provides a specific set of predefined columns for display.

Select Columns

This menu options allows you to customize the columns in a selected Document
Display.  The columns available will vary based upon the data being displayed. 
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Merge Cells

Merge Cells is a grouping function for displayed columns.  The grouping is based
on sort order and will group columns such as Date/Time and Event Types. 
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Status

These options will clear the Current and Peak Values columns on the Dashboard
document or when viewing the "Status" display in an Agent Document.

3.3 Documents

Document types are available in EM 7.0:

Dashboard
Agent
Start Page
Server Connect

Documents contain a collection of various section information that displays current
collected data.  These sections are grouped together using Document Views.

3.3.1 Dashboard

The Dashboard Document displays performance information based upon a
Performance Collector with pre-defined counters.  These collectors are configured
via the ELM Console and the Dashboard retrieves the information through a
database request.  Current and Peak counters are set through the Dashboard
notification method in the ELM Console and assigned to specific Event views to
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trigger the status change.

Details

Default columns include:

Name - This is the name of Agent being monitored.  This column is also a link to
the Agent Document.
Current - Based upon Dashboard Notification method and last status update.
Peak - Based upon Dashboard Notification method for highest status received.
Processor - Pages/sec, Interrupt time, Processor time, User time, Processor
Queue Length.
Memory - Bytes in Use, Avail Mbytes, Free System Page Entries, Pages/sec,
RAM, Nonpaged Bytes, Paged Bytes.
Disk - Bottleneck based on Free Space, Idle Time, Avg Queue Length, Read,
Write.
Free Disk -% Free Disk Space
Network - Received, Sent, Total, Output Queue Length

3.3.2 Agent

The Agent Document displays information specific to a selected agent.  
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Agent
The Agent document option allows you to change the Agent server you are
viewing.

Display
The Display option changes which type of data is displayed in an Agent
document.  Ex: Performance data, Network chart, etc.  Default display is Event
data.  Learn more about the various Document Displays.
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Table

Column Layout

Column layout options provides a specific set of predefined columns for display.

Select Columns

This menu options allows you to customize the columns in a selected Document
Display.  The columns available will vary based upon the data being displayed. 
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Merge Cells

Merge Cells is a grouping function for displayed columns.  The grouping is based
on sort order and will group columns such as Date/Time and Event Types. 
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3.3.2.1 Document Displays

Events

This default display shows the most recent 1000 events from the Windows Event log. As individual events are
selected, the message details for that particular event are displayed below in the Selected Row Details area.

Status

These options will clear the Current and Peak Values columns on the Dashboard
document or when viewing the "Status" display in an Agent Document.
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Performance Chart
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Performance Table
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Column Name Description
Date Date and Time generated
Object Performance Object Name
Counter Performance Counter Name
Instance Instance Name
Instance Value Collected Value of the Instance
Counter Value Minimum of the Instance Values

collected at the Date and time.
Calculated Counter (Selected Threshold)*(Maximum Value -

Counter Value)/(Maximum Value -
counter Threshold)

Calculated Bottleneck Calculated bottleneck is the maximum of
the Calculated Counter Values.

Maximum Value Value set internally. Blank when inverted
because the value is not used.

Selected Threshold Selected Threshold is 85 on a scale of 0
to 100. Calculated values above 85
indicate a possible bottleneck.

Counter Threshold Value at which the performance measure
changes from acceptable to undesirable.

Inverted Calculated values are Inverted if larger
values indicate more resources are
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available.

3.3.3 Start Page

The Getting Started Document provides a brief overview of the ELM Dashboard. 
The document may be configured to be hidden or appear when the Dashboard is
first started.  Navigation buttons are provide to move through various slides as an
introduction to the Dashboard.  See Getting Started for details on the slides.

3.3.4 Server Connect

The Connect Document allows you to connect the Dashboard to an ELM Server. 
Configurable options include a Resolvable ELM server Name and the Port on which
to connect.  

If the Dashboard is connected to an ELM server you will see status information
about that connect near the bottom of the Document.

Note: The default port for connecting a Dashboad to an ELM server is 1351.
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